
SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid

SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid

SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid SPHEREConstructing a Latitude / Logitude grid

1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 

viewed from our vantage point. 
It was the only completely 

unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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1.

To get started, we 
need some numbers.

Text Tool: Somewhere 
out of the way on 
your page, create a 
text object and type 

the text shown.

Tilt Angle: 
Tilt Sine: 
Tilt Cosine: 

2.

Decide upon an angle 
(in degrees) at which 
you want the axis of 

your globe to be 
tilted.

Looking edge-on at 
the equator would be 
zero degrees; looking 
straight down at the 
north pole would be 

90 degrees.

In this example, I’m 
using 30 degrees.

Enter the angle in 
your text field.

Launch Windows 
Calculator. 

From the View menu, 
select Scientific.

Select the Decimal 
radio button.

Select the Degrees 
radio button.

Enter your degree 
angle then click the 
Sin button. Copy the 

resulting value. 
Switch back to 

Illustrator and paste 
the value into your 

text object.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: 

3.

Switch back to 
Calculator. Clear the 

entry. Similarly obtain 
the Cosine of your tilt 
angle. (Three decimal 
places is a gracious 
plenty.) Copy it and 

paste it into your text 
object.

You may goof up a 
few times during this 
construction. The text 
object is just to serve 
as a reference if you 
need to recall the 

values.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

4.

Okay. We’ve got the 
values we need to get 

started.

Turn SmartGuides on.

Ellipse Tool: 
ClickShiftDrag to 

create a circle. This is 
the horizon of our 

globe.

Line Tool:

Mouseover the top 
point of the circle. 
When SmartGuides 

indicates you are over 
the anchor point, 

clickDrag downward 
to the anchor point at 

the bottom of the 
circle. This is the axis 
of our globe. Leave it 

selected.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

5.

DoubleClick the 
Rotate Tool.

Decide how many 
longitude lines you 

want in terms of their 
radial increment.

I’ve chosen to have 
longitude lines at 15° 

increments.

Note that you can 
enter values as a 

simple math 
expression if you 

want to. Just enter 
360  divided by the 

number of lines 
desired.

Click Copy.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

6.

Tap Ctrl-D (Transform 
Again) until the 

copies sweep 180°.

Select the circle and 
copy it to the 

clipboard. We will 
need to paste 

additional circles in 
place soon. 

Now...

Start thinking of this 
figure as a “side view” 

of your globe. The 
vertical line is the 

axis. The other lines 
are angular locators 

for each line of 
longitude. The 

horizontal line is the 
equator.

Select everything and 
Object>Lock.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

7.

Change the current 
stroke color to 

orange.

Line Tool:

Letting SmartGuides 
indicate when you are 
at the end points of 
the diagonal lines, 

draw a horizontal line 
across the “side view” 
of the globe at each 

latitude.

These are the “side 
views” of each 
latitude circle.

Draw a vertical line 
along the axis.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

8.

Selection Tool (black 
pointer):

Drag a selection 
marquee around all 
the orange stuff.

Now imagine what 
would happen in this 
side view if the axis 
tilted directly toward 
you, rotating about 

its center.

The axis would 
become foreshortened 
in height. How much? 
It would shorten by a 
factor equal to the 

cosine of the amount 
it tilted.

DoubleClick the Scale 
Tool. Key in 100% for 
horizontal scale; and 
the cosine of your 

angle expressed as a 
percentage for the 

vertical scale.

Click OK.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

9.

This is still a “side view” of our 
globe under construction. But 
the globe has rolled toward us 
30 degrees. This makes the axis 

appear foreshortened.

Of course, measures along the 
axis have also been 

foreshortened. That’s why we 
included the latitude lines in 

the scaling.

But of course, if those orange 
latitude lines were the “side 
view” of circles, they should 

now look like ellipses. So “shift 
mental gears” again and think 

of those orange horizontal lines 
not as the longitude circles 

themselves, but as diameters of 
the longitude circles.

Note that their widths did not 
change in the  scaling we 

performed; only their spacing 
did. This is because they 

represent the diameters which 
are perpendicular to our line of 
sight. In other words, they are 
the diameter about which each 
(presently invisible) latitude 

circle has rotated.

What we have here in the 
horizontal orange lines is the 

proper altitude along the 
foreshortened axis for each 
longitude. And because the 

orange lines are 
unforeshortened diameters of 
the longitude lines, they also 

indicate the major diameters of 
each longitude ellipse.

But what about the height of 
the ellipses?

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

10.

Well, the height of the equator 
ellipse is very easy: It is the 

sine of our tilt angle.

Deselect.

Paste In Front.

The circle we copied in step 6 
pastes in place. (I’ve colored it 

orange.)

DoubleClick the Scale Tool.

Horizontal is still set to 100%

Set vertical to the sine of our 
tilt angle.

Click OK.

This is what the equator circle 
looks like when it is rolled 

toward us 30°.

Of course, all the other latitude 
lines will be proportioned just 

like this, because they are 
tilted toward us at the same 

angle. So...

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

11.

Selection Tool:

Mouseover the centerpoint of 
the ellipse. SmartGuides will 
indicate “Center” when you 

find it. (If the center dot isn’t 
showing, click the Show Center 
icon in the Attributes Palette.)

Mousedown on the centerpoint 
and AltShiftDrag a copy 

straight upward, stopping when 
Smart Guides indicates you 
have intersected the first 

latitude radius north of the 
equator.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

12.

Selection Tool:

Mouseover the right side 
bounding box handle. 

Mousedown, press Alt and 
Shift, and drag slowly toward 

the left. The ellipse scales 
about its center, and 

proportionally. Stop dragging 
when SmartGudies indicates 

you have reached the endpoint 
of the orange diameter line.

Tilt Angle: 30°
Tilt Sine: 0.5
Tilt Cosine: .866

13.

Selection Tool:

Mouseover the center of this 
ellipse. Mousedown and 

AltShiftDrag another copy to 
the next northward latitude 

diameter.

14.

Selection Tool:

Mouseover its right side 
bounding box handle. 
AltShiftDrag to scale it 

proportionally until it is the 
width of the latitude diameter 

line.

15.

And so on for the rest of the 
northern latitudes

Go back to the equator and do 
the same thing for the 
southern hemisphere.

Our set of latitude lines is 
complete.

Now for the longitudes.

16.

Select all the latitudes, group 
them, and drag the Group off to 
the side so our view will be less 

cluttered as we work on the 
longitude lines.

But leave the latitude diameter 
lines where they are.

17.

Paste In Front.

Another circle appears. Stroke 
this one with green.

18.

Paste In Front.

Another circle appears. Stroke 
this one with green.

Selection Tool:

AltDrag the top center 
bounding box handle straight 
downward until SmartGuides 

indicates you have reached the 
north pole.

Now look at the drawing and 
consider what this ellipse 

represents.

It started as a circle idential to 
our horizon circle. It was the 
“great circle” of the sphere as 
viewed from our vantage point. 

It was the only completely 
unforeshortened circumfrence 
of the globe, because it was 

the circumference 
perpendicular to our line of 

sight.

By scaling it vertically, we 
“tilted” it toward us 30°.

It is a longitude line, so of 
course it crosses both the tips 
of the north and south poles. 
Note how neatly it now also 
“happens” to enscribe the 
latitude diameters we have 

been working with.

19.

Copy.

Paste In Front.

AltDrag the top middle handle 
of the copy’s bounding box 

down to where the first 
horizontal orange line 

intersects the vertical axis.

Now here we have the next 
longitude ellipse. It’s 

foreshortened more than the 
first one as it should be. But 

this one needs to be different, 
because it has to be rotated in 
two planes, not just one. That 
is, before it was “rolled toward 

us”, it would have been 
“rotated” relative to our line of 
sight, because longitude circles 

are not parallel.

So what do we do?

Thankfully, we have a handy 
mechanism to make things 
right staring us right in the 

face: the north pole.

All longitude circles cross at 
the poles. Therefore…

DoubleClick the Rotate tool. 
Enter 1° for the rotate angle. 

Click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

20.

Paste In Front.

As before, AltDrag the top 
middle handle of the copy’s 

bounding box down to where 
the second horizontal orange 

line intersects the vertical axis.

DoubleClick the Rotate tool. 1° 
is still entered, so just click OK.

Press Ctrl and tap D repeatedly 
while watching the edge of the 

ellipse. Stop when the edge 
neatly crosses the endpoint of 

the north pole.

21.

And so on until you have done 
a longitude ellipse for one half 

of the sphere.

22.

Select the green longitude 
lines.

DoubleClick the Reflect tool. 
Select the Vertical radio button 

and click Copy.

You now have all the longitude 
lines except for the center one, 
which we are viewing :”edge 

on.”

23.

Line Tool:

Draw a vertical line all the way 
across the great circle of the 

globe.

Now we have the full set of 
longitude lines.

24.

Select all the longitude lines. 
(If you’ve been using a unique 
color for these, you can use 
Select>Same>Stroke Color.)

Group.

Shift select the latitude Group 
to add it to the selection. 

Allign the two Groups 
horizontally and vertically. 

25.

Rotate the whole thing and 
Stylize as desired, then correct 

stacking order as needed.

Depending upon how you 
stylize the thing, you may want 

to split the ellipses to send 
half of them to the rear, or to 

delete the “back” halves.

Longitude lines always touch 
the horizon circle at their 

major diameters, so their “back 
sides” can be removed by 

simply selecting and deleting 
one point.

Latitude lines will have to be 
cut where they contact the 

horizon circle. 
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